
 

 

QUESTION 1 
In which folder is REGEDIT found in Windows 9x? 
A. WINDOWS 
B. WINDOWS\INF 
C. WINDOWS\COMMAND 
D. WINDOWS\SYSTEM32 
Answer: A 
Explanation:  
The regedit utility is found in the Windows directory on a Windows 9x system. 

 

QUESTION 2 
How should you create a FAT16 partition in Windows 98? 
A. FAT16 is not supported in Windows 98. 
B. Select Y when prompted for large partition running Fdisk. 
C. Select N when prompted for large disk support running Fdisk. 
D. Select N when prompted for Extended partition when running Fdisk. 
Answer: C 
Explanation:   
By selecting N when prompted for large disk support in FDISK the FAT16 file system will be selected. 
Note:  
Large disk support provided with FAT32 supports disk up to 2TB in size. FAT16 partitions are limited to 2GB 
in size. 

 

QUESTION 3 
How are hidden files unhidden in Windows 98? 
A. Tools, options, show all files. 
B. Control panel, system, show all files. 
C. Start, settings, file settings, show all files. 
D. Windows explorer, view, folder options, view, show all files. 
Answer: D 
Explanation:  
In Windows 9x system file can be unhidden from the View menu of the Windows Explorer program. 

 

QUESTION 4 
Where can the Screen Saver password be set in Windows 9x? 
A. Start, Run, set Screen Saver Settings 
B. Control Panel, Display, Screen Saver, Settings 
C. Start Programs, Accessories, Display, Screen Saver, Set Password 
D. Control Panel, System Properties, Device Manager, Display Adapter, Set Password 
Answer: B 



 

 

Explanation:  
Screen Save password configuration belongs to the Display Settings. 

 

QUESTION 5 
What happens when Windows 98 detects a corrupted registry? 
A. Windows 98 needs to be reinstalled. 
B. You must boot to safe mode and restore from your backups. 
C. Windows will automatically restore a backup copy of the registry. 
D. You must boot from your emergency disk and restore the registry. 
Answer: C 
Explanation:  
Windows Registry Checker automatically scans the system registry for invalid entries and empty data blocks 
when it is started. If invalid registry entries are detected, Windows Registry Checker automatically restores a 
previous day's backup. 
Reference:  
Description of the Windows Registry Checker Tool (Scanreg.exe) (Q183887) 

 

QUESTION 6 
What file is needed to start up Windows NT 4.0? 
A. NT.INI 
B. BOOT.INI 
C. CONFIG.SYS 
D. AUTOEXEC.BAT 
Answer: B 
Explanation:  
The BOOT.INI file is a required Windows NT/2000/XP startup file. 
Incorrect Answers 
A: There is no file called NT.INI. 
B: CONFIG.SYS and AUTOEXEC.BAT are used in Windows 9x systems not on Windows NT 4.0. 

 

QUESTION 7 
Which command can repair a master boot record? 
A. FDISK/MBR 
B. CHKDSK/MBR 
C. FORMAT/MBR 
D. SCANDISK/MBR 
Answer: A 
Explanation:  
The FDISK/MBR command repairs the master boot record. 



 

 

Incorrect Answers 
The /MBR switch cannot be used with CHDSK, FORMAT, or SCANDISK commands. 

 

QUESTION 8 
How can the operating system version that is currently running be found? 
A. Right click the Task bar and select Properties. 
B. Right click the Desktop and select Properties. 
C. Right click the My Computer icon and select Properties. 
D. Open any application, select help from the toolbar and Choose abort 
Answer: C 
Explanation:  
The version of the Operating system can usually be found by right-clicking the My Computer icon and selecting 
Properties. 

 

QUESTION 9 
Which file must be changed to add multiboot capabilities in Windows 9x? 
A. IO.SYS. 
B. SYSTEM.INI. 
C. MS-DOS.SYS. 
D. CONFIG.SYS. 
Answer: C 
Explanation:  
MS-DOS.SYS contains multiboot information in a Windows 9x system. It can be compared to the BOOT.INI 
file of Windows NT/2000/XP/.NET. 

 

QUESTION 10 
What must be done from the command prompt before the MSDOS.SYS file can be edited in Windows 9x? 
A. RUN SYSEDIT 
B. RUN REGEDIT 
C. ATTRIB-S-H-R MSDOS.SYS 
D. ATTRIB+S+H+R MSDOS.SYS 
Answer: C 
Explanation:  
The MSDOS.SYS file is a system file (S attribute), which is hidden (H attribute), and set as Read-Only (R 
attribute). We must remove the system, hidden and 
read-only attributes with the attrib command. We should use –S-H-R to remove   attributes. +S+H+R would add 
those attributes. 

 



 

 

QUESTION 11 
How are hidden files unhidden in Windows 95? 
A. Tools, options, show all files. 
B. Windows explorer, view, options, show all files. 
C. Windows explorer, file, preferences, unhide all files. 
D. Control panel, device manager, file attributes, unhide. 
Answer: B 
Explanation:  
In Windows 9x you use the View menu of Windows explorer to show hidden files. 
Note: In Windows 2000/XP the Tools menu is used for this purpose. 

 

QUESTION 12 
Which backup method is generally the quickest and requires the least amount of backup storage space? 
A. Daily. 
B. Normal. 
C. Differential. 
D. Incremental. 
Answer: D 
Explanation: 
 Incremental backups only back up the files that have changed since last backup. Incremental backup is the 
quickest backup method.  
Note:  
The drawback with incremental backups is that the restore process takes longer timer. 
Incorrect Answers 
A: The daily backup method copies all files. 
B: The normal backup method copies all files. 
C: The differential backup method copies all files that have changed since the last full backup was performed. 

 

QUESTION 13 
Where would you capture a printer port for a network printer in Windows 9x, My Computer, Control Panel? 
A. Printer palette, File, Properties, Details. 
B. Printer applet, File, Properties, Details. 
C. Network Applet, File, Properties, Detail 
D. Add/Remove program applet, properties, Detail 
Answer: B 
Explanation:  
The Printer Applet is used to capture a printer port. 
Incorrect Answers 
The other answers are worse: 
A: There is no such thing as a Printer palette. 
C: The Network applet is not use to map a networked printer. 
D: The Add/Remove program applet is used to add and remove programs, not to configure printer settings. 



 

 

 

QUESTION 14 
Which command should you use to test connectivity to every router between your system and a destination 
system? 
A. PING. 
B. ROUTE. 
C. TRACERT. 
D. WINIPCFG. 
Answer: C 
Explanation:  
TRACERT is used to trace routes throughout the network. The path through the network will show all routers 
included in the path. 
Incorrect Answers 
A: PING only shows if the connection was successful or not. It does not show any information on routers in the 
path. 
B: The ROUTE command displays the routes in the routing table on a router. 
D: WINIPCFG is used on Windows 9x computers to configure and manage IP. 

 

QUESTION 15 
Where can you change network identification in Windows 2000? 
A. Device manager. 
B. Network properties. 
C. System properties. 
D. Network and dial up connections. 
Answer: C 
Explanation:  



 

 

The network identification on a Windows system can be changed in System properties. 

 

 

QUESTION 16 
To reach a secured internet site named test.com which of the following addresses must you type on the URL 
line of your browser? 
A. HTTP://TEST.COM 
B. HTTPS://TEST.COM 
C. TELNET HTTP://TEST.COM 
D. HTTP://CURE.HTML/TEST.COM 
Answer: B 
Explanation:  
HTTPS is based on the Secure Socket Layer protocol (SSL). HTTPS is used to access secure sites. 

 

QUESTION 17 
Which of the following network protocols are included with Windows 2000? (Choose three) 
A. ENX. 
B. DEC NET. 
C. NWLINK. 
D. NETBEUI. 
E. APPLETALK. 
Answer: C, D, E 
Explanation:  
Nwlink (Microsoft version of IPX/SPX), NetBEUI, and APPLETALK are supported by Windows 2000. 



 

 

 

QUESTION 18 
Which network protocols can you load to share printer in Windows 9x? (Choose three) 
A. PPTP 
B. TPTPC 
C. TCP/IP 
D. NETBIOS 
E. NETBEUI 
F. IPX/SPX 
Answer: C, E, F 
Explanation:  
Windows 9x supports the network protocols TCP/IP, NetBEUI and IPX/SPX (through NWLink). 
Incorrect Answers 
A: Point to Point Tunneling Protocol is for WAN connections, and not on a local network. 
B: There is no protocol named TPTPC. 
D: NetBIOS is not a protocol. I 

 

QUESTION 19 
Where would you rename a printer that you shared on the network using Windows 9x? (Choose two) 
A. My Computer, Printers. 
B. Start, Settings, Printers. 
C. Start, Accessories, System utility, Printers. 
D. Start, Programs, Accessories, System tools, Printer setup. 
E. My Computer, Control Panel, System, Device Manager, Ports, Printers. 
Answer: A, B 
Explanation: 
In Windows 9x we use the Printers folders to access and configure printers, including changing their name. The 
Printers folders can be reached through either My Computer or via Start->Settings. 

 

QUESTION 20 
Which of the following files need to be included on a boot diskette for Windows 9x to enable CD-ROM 
support? (Choose three) 
A. BOOT.INI. 
B. CDHLP.SYS. 
C. MSCDEX.EXE. 
D. COMMAND.COM. 
E. AUTOEXEC.BAT. 
Answer: C, D, E 
Explanation: 
C: MSCDEX.EXE is used for CD-ROM in with real-mode drivers. 
D: COMMAND.COM is used to execute the commands in the AUTOEXEC.BAT file. 



 

 

E: AUTOEXEC.BAT is used to load the MSCDEX.EXE command. 
Incorrect Answers 
A: BOOT.INI is a Windows NT/2000/XP file startup file. 
B: CDHLP.SYS is not a required startup diskette. 

 

QUESTION 21 
In Windows 2000 which file can you edit to alter multiple OS boot options? 
A. IO.SYS 
B. BOOT.INI 
C. SYSTEM.INI 
D. MS-DOS.SYS 
Answer: B 
Explanation: 
In Windows NT/2000/XP the boot.ini file is used for multi-boot purposes. 
Incorrect Answers 
A, D: IO.SYS and MS-DOS.SYS are used in Windows 9x, but not in Windows 2000. 
C: System.ini does not contain multi-boot settings. Windows 2000 only use system.ini for backward 
compatibility. 

 

QUESTION 22 
You see a dialogue box on your Windows NT 4.0 workstation stating that Dr.Watson has detected an error and 
is creating a log file. Where can you find the 
file to review what has caused the error? 
A. SQL\. 
B. C:\Winnt. 
C. C:\Winnt\system. 
D. C:\Winnt\system32. 
Answer: B 
Explanation:  
On Windows NT 4.0 system the Dr.Watson log file is save in the %SystemRoot% which usually is the 
C:\Winnt folder.  
Rerefence: 
Interpreting the DrWtsn32.log File to Identify Program Crash Data (Q246084) 

 

QUESTION 23 
You change the video resolution. When you restart the system you can no longer see anything on the screen. 
Even though you are sure that the system booted up properly. What should you do to safely restart the system so 
that you can access the display properties in safe mode? 
A. Press CTRL+ALT+DEL twice 
B. Press the reset button on the computer. 



 

 

C. Press ALT + F4 and then press enter. 
D. Pull the power cord from the back of the computer. 
Answer: C 
Explanation: 
On a Windows 9x system we can close the operating system by ALT+F4 (close the current 
application/windows) and Enter (confirms that system should be 
restarted). On a Windows NT/2000 system we would have to use the reset button. 

 

QUESTION 24 
You are working on a system that has a malfunctioning mouse. In the device manager which key will toggle 
from one device to another? 
A. TAB 
B. HOME 
C. ENTER 
D. ARROW KEY 
Answer: D 
Explanation:  
The arrow keys can be used in Device Manager to select the appropriate device. 

 

QUESTION 25 
You have just installed a Windows 98 workstation using the IPX protocol in aMicrosoft network but you can't 
browse any other stations on the network. The 
client for the Microsoft networks is installed in the Control Panel network configuration. What should you do to 
allow the workstation to browse the network? 
A. Enable file and print sharing. 
B. Verify the workstations IPX address. 
C. Enable browsing services in the Control Panel. 
D. Enable NetBIOS support in the network configuration. 
Answer: D 
Explanation:  
Windows 98 clients require NetBIOS names support for browsing. 
Incorrect Answers 
A: File and print sharing is required for browsing. 
B: The IPX address is not configurable, as the IP address for example. The IPX address cannot be the cause of 
the problem. 
C: The browsing service cannot be configure from the Control Panel on Windows 9x systems. 
Note:  
In Windows NT/2000/XP/.NET the workstation service is used for browsing. 

 



 

 

QUESTION 26 
Your client wants to be able to share one Internet connection with other PCs. Which versions of Windows 9x 
has been designed to do this? 
A. Windows 98. 
B. Windows 98 SE. 
C. Windows 95 OSR2. 
D. Windows 95 Retail Version. 
Answer: B 
Explanation: 
Windows 98 Second Edition (SE) supports Internet Connection Sharing (ICS). All newer Windows versions 
supports ICS. 

 

QUESTION 27 
You are working on a system that has a malfunctioning mouse. You need to navigate through windows to check 
the device manager for conflicts. What toggles 
you from the Desktop to the Taskbar? 
A. <ALT> 
B. <TAB> 
C. <CTRL> 
D. Arrow key. 
Answer: B 
Explanation:  
The Tab key can be used to toggle from the Desktop to the Task bar. 

 

QUESTION 28 
What does an incremental backup do? 
A. Full backup of all files. 
B. Same differential backup. 
C. Backup of file only that have increased in size. 
D. Backup all files that have the archived bit turned on. 
Answer: D 
Explanation:  
An incremental backup includes all the files that have changed since the last full backup. To keep track of the 
files that have changed the Operating system uses 
the archive bit. Whenever a file is altered the archive bit is set. 
Incorrect Answers 
A: A full backup includes all files. 
B: Differential backups backs all files that has changed since last full backup, but an l backup only backs up all 
files that has changed since last incremental or 
last full backup was performed. 
Note:  
The difference between differential and incremental can also be said that the differential backup never changes 



 

 

the archive bit of any files, while the incremental 
backup clears the archive bit for every file that it backs up. 
C: The incremental backup backs all files that have changed, not only the ones the have increased in size. 

 

QUESTION 29 
When reinstalling Windows 95 on an existing installation on the same directory how are the existing group 
items preserved? 
A. Automatically. 
B. By saving all .INI files. 
C. By saving all .GRP files. 
D. By saving all .INI, SYSTEM.DAT and .GRP file. 
Answer: A 
Explanation:  
Existing group items are automatically preserved when reinstalling Windows 95 in the same directory. 

 

QUESTION 30 
A custom application is conflicting with another application. What can you do to fix the problem temporarily on 
a Windows NT system? 
A. Run MS config. 
B. Run REGEDT32. 
C. Reinstall the application. 
D. Run the application in a protected memory space. 
Answer: D 
Explanation:  
By forcing the application to run in its own memory space it would not be able to crash other applications. 


